For more information please contact:

Genomatix Software GmbH
Bayerstr. 85a
80335 Munich
Germany

Phone: +49 89 599766 0
Fax: +49 89 599766 55
Email: info@genomatix.de
WWW: http://www.genomatix.de

© 2011 Genomatix Software GmbH
# Table of Contents

1. Introduction to ChipInspector .................................................................................. 4  
   1.1 What is Genomatix ChipInspector? ...................................................................... 4  
   1.2 Which Pages in the Manual Should I Read First? .................................................. 4  

2. Theoretical Background .......................................................................................... 5  
   2.1 Rationale of the Single Probe Approach ............................................................... 5  
   2.2 Normalization and Fold Change Calculation ....................................................... 6  
   2.3 Statistical Evaluation ............................................................................................ 7  
   2.4 File Combinations ................................................................................................. 9  
   2.5 One Class Analysis (Experiment versus Control) ............................................... 10  
   2.6 Multiclass Analysis .............................................................................................. 10  
   2.7 Absolute Expression Value .................................................................................. 10  
   2.8 Projection ........................................................................................................... 10  

3. Supported Microarray Platforms ............................................................................ 11  
   3.1 Affymetrix Microarrays ....................................................................................... 11  
   3.2 Agilent Microarrays ............................................................................................ 11  
   3.3 Illumina Microarrays .......................................................................................... 11  
   3.4 Platforms and Probe Numbers ............................................................................ 12  

4. File Requirements ................................................................................................... 14  

5. Technical Requirements .......................................................................................... 14  
   5.1 Operating Systems ............................................................................................. 14  
   5.2 Java Runtime Environment ................................................................................ 15  

6. Installation and Configuration of ChipInspector .................................................. 17  
   6.1 Download ........................................................................................................... 17  
   6.2 Get Login and Password ..................................................................................... 19  
      6.2.1 Registration ................................................................................................... 19  
      6.2.2 Change Password ......................................................................................... 22  
      6.2.3 Password Policy ............................................................................................ 24  
   6.3 Installation .......................................................................................................... 24  
   6.4 Configuration of ChipInspector .......................................................................... 26  
      6.4.1 Proxy Configuration ....................................................................................... 26  
      6.4.2 Configuring automatic updates ..................................................................... 27  
      6.4.3 Selecting a Data Server ................................................................................ 28  
      6.4.4 Configuring the Java memory settings ........................................................... 29  

7 Step-by-step: Performing a ChipInspector Analysis ............................................. 30  

8 Variant: Chromatin-IP workflow ............................................................................ 35  

9 The ChipInspector Workspace Area ....................................................................... 36  
   9.1 The “Projects” Window ....................................................................................... 37  
   9.2 The “Probes” Window ........................................................................................ 37  
   9.3 The “Transcripts” Window .................................................................................. 38  
   9.4 The “Genome Browser” Window ........................................................................ 40

© 2011 Genomatix Software GmbH
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.5</td>
<td>The “Gene Information” Window</td>
<td>41</td>
</tr>
<tr>
<td>9.6</td>
<td>The “Alternative Transcripts” Window</td>
<td>42</td>
</tr>
<tr>
<td>9.7</td>
<td>The “Significance Curve” Window</td>
<td>43</td>
</tr>
<tr>
<td>9.8</td>
<td>The “Properties” Window</td>
<td>43</td>
</tr>
<tr>
<td>9.9</td>
<td>The “Probe Filters” Window</td>
<td>44</td>
</tr>
<tr>
<td>9.10</td>
<td>The “Transcript Filters” Window</td>
<td>45</td>
</tr>
<tr>
<td>9.11</td>
<td>The “Unique Probe Statistics” Window</td>
<td>45</td>
</tr>
<tr>
<td>9.12</td>
<td>The “Memory Monitor”</td>
<td>46</td>
</tr>
<tr>
<td>10</td>
<td>Projects and Analyses</td>
<td>47</td>
</tr>
<tr>
<td>10.1</td>
<td>Creating a New Project</td>
<td>47</td>
</tr>
<tr>
<td>10.2</td>
<td>Opening an Existing Project</td>
<td>48</td>
</tr>
<tr>
<td>10.3</td>
<td>Saving the Project Tree</td>
<td>48</td>
</tr>
<tr>
<td>10.4</td>
<td>Deleting a Project</td>
<td>48</td>
</tr>
<tr>
<td>10.5</td>
<td>Importing Data Files into a Project</td>
<td>48</td>
</tr>
<tr>
<td>10.6</td>
<td>Editing a Project</td>
<td>52</td>
</tr>
<tr>
<td>10.7</td>
<td>Creating a New Analysis</td>
<td>53</td>
</tr>
<tr>
<td>10.8</td>
<td>Committing an Analysis for a Batch Job</td>
<td>57</td>
</tr>
<tr>
<td>10.9</td>
<td>Exporting Results</td>
<td>58</td>
</tr>
<tr>
<td>10.9.1</td>
<td>Data Export</td>
<td>58</td>
</tr>
<tr>
<td>10.9.2</td>
<td>Bed-file Export</td>
<td>58</td>
</tr>
<tr>
<td>10.9.3</td>
<td>Transcript List Export</td>
<td>59</td>
</tr>
</tbody>
</table>
1. Introduction to ChipInspector

1.1 What is Genomatix ChipInspector?

ChipInspector analyzes raw data files from microarray experiments. It selects those probes from the chip, where the signal is significantly different from the background and puts them in their biological context.

ChipInspector extracts significant information from the expression level of single probes of Affymetrix GeneChip® microarrays, Agilent DNA microarrays and Illumina® whole-genome gene expression arrays. The program uses the world's largest database of alternative transcripts and promoters to achieve superior signal-to-noise ratios in microarray analysis. It is unique in removing statistical and gene calling errors at the single probe level. This annotation driven microarray analysis technology provides the basis for unmatched accuracy in significance analysis of microarray data. It increases the number of significant features while simultaneously reducing false positive rates by an order of magnitude. The resulting lists of significantly regulated genes from the experiment are directly usable as input for pathway mining tools such as Genomatix’ BiblioSphere PathwayEdition.

ChipInspector includes only a rudimentary tool set for quality assessment of microarrays. Low level quality assessment of the hybridization and thus the success of the experiment can be performed with a number of good and cost-free tools such as the Affymetrix TAS software, Agilent’s Feature Extraction or Illumina’s BeadStudio.

The Genomatix approach puts its focus on the biological knowledge that is accumulated and stored in the annotation. The annotation is made independently of the information and the intention at the time of design of the array. Thus the data taken from the experiment is reduced to information about hybridization signals, the biological implications are calculated on the basis of the most current state of the genome.

1.2 Which Pages in the Manual Should I Read First?

Chapter 7 takes you through a step-by-step example of an expression array analysis. If you wish to go to greater depths in understanding the inner workings of the program, read Chapter 2 of this manual for theoretical considerations about the statistics and the scientific rationale behind ChipInspector. Chapter 6 gives information about the installation and configuration of the program and points to other resources for additional technical information.

The “FAQ” item in the programs “Help” menu takes you to our website, where some of the most commonly appearing issues are posted. This is continuously updated. It will also refer you to a download area where you can obtain a pre-calculated and configured example project.
2. Theoretical Background

2.1 Rationale of the Single Probe Approach

The definition of probe sets greatly eases the handling of the large data amounts that are produced by microarray experiments. Considerable thought has gone into the design of the probes regarding comparable hybridization temperatures, GC content and genomic position to create sets of single probes for one transcript. Gene expression levels are calculated as cumulated signals from several probe expression values. The algorithms used for calculating this cumulated signal assume that all probes in a set represent only one specific target sequence (i.e. one transcript). In many cases, this sequence information is outdated today as genomic annotations are becoming more and more complete. Today it can be seen from the latest genomic annotations that most genes are flexible entities which are translated into different mRNAs (alternative transcripts). These variants were often not or only partially known at the time of the array design thus leading to ambiguous probe design, i.e. probes cannot be assigned uniquely to different gene variants. Therefore the probes in a probe set are often distributed among different (alternative) transcripts of the same gene locus. As a consequence, the calculated signals do not reflect the expression value of the gene properly.

Figure 1: Assay sensitivity is increased by a single probe approach.
With increasing computing power available to desktop/benchtop computers, the advantages of the single probe approach can be accessed. The annotation is always up-to-date even if some of the probes, which were originally included in a probe-set are now annotated differently. The pooling of the single probe signals is forfeited, therefore decreasing the chance of combining signals which are independent of each other. Consider Figure 1 to view the difference between the single probe and the probe-set approach.

The above comments hold especially true for the new generation of tiling arrays and the subsets of exon tiling and promoter tiling arrays. Here, the single probe approach disregards the previously known annotation altogether, thus allowing transcript specificity and the discovery of new splice variants when exons are assembled in a previously unknown combination. A caveat at this point: The tiling array probes are mapped strand-specifically. A tiling array approach using single-strand RNA would lead to a loss of detection of transcripts.

The basis for ChipInspector is the Genomatix proprietary probe to transcript assignment based on the mapping of all probes of a microarray against the most current version of the genome of interest. The genomic data is available in the Genomatix gene annotation browser Eldorado. Only probes which map perfectly and uniquely in transcripts of the genome of interest are used for the analysis. This information is saved in mapping files which are an integral part of the program. Mapping files are updated and provided for automatic download by ChipInspector as soon as an updated version of a genome becomes available.

### 2.2 Normalization and Fold Change Calculation

Initial to the significance calculation for a microarray experiment, the raw data is normalized on the single probe level, i.e. the values are adjusted to improve consistency and reduce bias. Each value of an array is multiplied by a constant to make the mean intensity the same for each individual array.

Fold changes are subsequently calculated by probe wise division of the expression values from the experimental condition by the expression values from the control condition and, finally, a logarithmic transformation ($\log_2$) is performed for each data point.

Because values are calculated for the single probes, ChipInspector calculates differing fold changes when compared to a probe-set-based analysis strategy. The transcripts are deemed significant if they are detected by a user-selected number of significant probes and the fold change value for a transcript is the mean value of the detected fold changes in the significant single probes, not in the complete probe set. This should be kept in mind when the resulting list of significant transcripts is further condensed by introducing a minimum fold change filter.
2.3 Statistical Evaluation

The statistic algorithm in ChipInspector is a T-test with a permuted artificial background. It is based on and enhances the original SAM algorithm by Tusher et al. (2001): Significance analysis of microarrays applied to the ionizing radiation response. PNAS 98(9), pp 5116-5121.

This algorithm creates artificial background data by randomly permuting the array results. Each probe has a score on the basis of its fold change relative to the standard deviation of repeated measurements for this probe. Probes with scores higher than a certain threshold are deemed significant. This threshold is the Delta value. The permutations of the data set are then used to estimate the percentage of probes identified by chance at the identical Delta. Thus, a relation of significant probes to falsely discovered probes can be given for each Delta threshold. This relation is the False Discovery Rate FDR, a stringency indicator. The FDR is a confidence value giving the user an idea of how many probes in the result group are possibly falsely selected.

The ChipInspector algorithm calculates these numbers independently for the sets of positive and negative data points where applicable (i.e. in a one-class assay).

The resulting curve is displayed in ChipInspector. It represents an indication of the experiment’s success in showing the amount of probes which deviate from the signal background. Figure 2 shows the observed (=real) values in the Y-axis over the expected (=background) values in the X-axis. The line pictures the expected values. The single data points are ordered by their individual significance score; values deviating downward are displayed left of center (lower than the expected values), values deviating up are displayed right of center (higher than the expected line). Most of the data points will deviate little from the straight line, only in the extremes of the set is a marked change in observed versus expected signal visible.

When the cutoff values $\Delta_{\text{pos}}$ and $\Delta_{\text{neg}}$ are changed interactively by the user, the program recalculates the set of deviating probes, i.e. those regulated by the experimental condition.

Decreasing the $\Delta$ value yields more significant features at the cost of increasing likeliness to find false positives. Increasing $\Delta$ diminishes the group of detected probes; the resulting set has a higher stringency, i.e. less danger of including falsely detected probes.

A slightly different picture is obtained when the analysis is run as multi-class analysis. Here, the features cannot be separated into down- and up-regulated groups, since the fold changes are calculated individually for each class. Each feature may thus be up-regulated in one and down-regulated in another class, e.g. at a different time point in the experiment.

The statistical score is therefore calculated as a deviation from the expected absolute behavior of the average feature; there are no negative ratios in this case. The resulting curve is shown in Figure 3.

There is no "magic number" or recommendation for $\Delta$ or the resulting FDR. This is an experiment-specific value, a trade-off where the user has to decide on the stringency level.
that she requires for her results. The user chooses the statistical significance of the calculated ratios from the statistics curve. All the selected probes and thus the resulting projected transcripts are then significant with this FDR. With increasing $\Delta$, the curve diverges away from the linear gradient. Experience shows that there is often a point where a sudden distinct decrease in the number of significant features happens and this is usually a good point to set the cutoff. It cannot be stressed too often that microarray analysis needs to be complemented by a biological evaluation of the results.

**Figure 2**: Graphic output of the ChipInspector statistical calculation for a Treatment/Control analysis. The plot shows the observed (=actual) relative fold change ratios in the Y-axis over the expected (=background) ratios in the X-axis. The features with deviating values (i.e. $>\Delta$) are regulated by the experimental condition.
2.4 File Combinations

Due to the fact that the statistical evaluation of the experimental data is carried out with the data from single probes, replicates are needed to create enough data points. ChipInspector cannot be used with only one replicate. We strongly recommend a minimum of three replicates per experimental point, although it is possible to work with two replicates. If only 2 samples and 2 controls are available, the array parameter for file combination can be set to "exhaustive pairing" to create 4 combinations (S1/C1, S1/C2, S2/C1, S2/C2). This is statistically tolerable and will be sufficient to run the analysis. The results will still have less confidence (higher False Discovery Rates) than when 3 samples are used.

Exhaustive matching of the experiments introduces a second level of data volume enhancing. This means it is using the complete set of available data points by matching the values from every condition experiment to the values from every control experiment. With pair-wise matching, only a subset of this data is used. Since the background data volume is thus increased, the individual outliers from each experiment are leveled out and therefore signal is separated more sharply from background noise. This gives the results greater confidence and therefore increases the number of values that are recognized as significant (higher number of significant genes with lower FDR). This is feasible when not comparing individuals (e.g. patient samples).
2.5 One Class Analysis (Experiment versus Control)

This analysis is suited for the comparison of two experimental groups such as "knockout versus wild-type", "treated versus untreated", or "diseased versus healthy".

2.6 Multiclass Analysis

This analysis is suited for kinetic or titration experiments with more than two data points.

2.7 Absolute Expression Value

This analysis is suited for comparing individual probe signals against the average chip expression value.

2.8 Projection

The approach to microarray analysis in ChipInspector is annotation driven. In contrast to most other software packages, ChipInspector does not rely on the predefined probe to transcript assignment done by the chip manufacturer at the time of the chip design. ChipInspector includes a new probe to transcript association performed by the Genomatix proprietary mapping pipeline based on an up-to-date genome (ElDorado).

Significant probes are projected to transcripts using pre-calculated mapping files. As default value, three significant probes are needed to detect a transcript as significant. This figure of three probes was determined empirically via spike-in experiments and proved to produce a low false positive rate while maintaining high sensitivity. However, the number of probes to define a transcript can be adapted by the user.

The restriction of the number of transcripts marked as significant by requiring a minimum number of significant probes to match this transcript is a form of biological quality checking.

More than one transcript can be annotated at a locus, therefore many (if not most) probes are mapped to multiple transcripts.
3. Supported Microarray Platforms

3.1 Affymetrix Microarrays

Array formats from Affymetrix (Affymetrix Inc., Santa Clara, CA, USA) are recognized automatically when the corresponding raw data files ("CEL"-files) are imported into a ChipInspector project.

3.2 Agilent Microarrays:

The unique identifier for Agilent (Agilent Technologies Inc., Santa Clara, CA, USA) probe sequences is the "featureNum" entity, which is displayed in column 2 of the Agilent scanner output. If the output comes from a GenePix scanner, the corresponding unique identifier is the "RefNumber" in column 57.

3.3 Illumina Microarrays

The unique identifier for Illumina (Illumina Inc., San Diego, CA, USA) probe sequences is the ArrayAddressID, which is displayed in the Bead Studio output.

For array formats from Agilent and Illumina automatic recognition is not implemented. During file import, you are asked to identify the chip type and the column of your tab-delimited raw data file, where the unique probe identifier is marked. In addition, these array formats do not use the probe-set approach. The coverage should therefore be set to 1 (cf. chapter 9.10).

Genomatix calculates a proprietary annotation for the database ElDorado. ChipInspector data is based on this. For the currently supported chips, more than 85% of the perfect match probes are used to calculate the statistics. The following tables show the data for each chip.
### 3.4 Platforms and Probe Numbers

<table>
<thead>
<tr>
<th>Affymetrix exon arrays</th>
<th>Number of columns / rows</th>
<th>Perfect match probes (Genomatix optimized)</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Exon 1.0 ST</td>
<td>2560</td>
<td>4983374</td>
<td></td>
</tr>
<tr>
<td>Human Gene 1.0 ST</td>
<td>1050</td>
<td>732795</td>
<td></td>
</tr>
<tr>
<td>Human Gene 1.1 ST Plate</td>
<td>1190/990</td>
<td>744981</td>
<td></td>
</tr>
<tr>
<td>Mouse Exon 1.0 ST</td>
<td>2560</td>
<td>4406226</td>
<td></td>
</tr>
<tr>
<td>Mouse Gene 1.0 ST</td>
<td>1050</td>
<td>752965</td>
<td></td>
</tr>
<tr>
<td>Mouse Gene 1.1 ST Plate</td>
<td>1190/990</td>
<td>750883</td>
<td></td>
</tr>
<tr>
<td>Rat Gene 1.0 ST</td>
<td>1050</td>
<td>169630</td>
<td></td>
</tr>
<tr>
<td>Soy Gene 1.0 ST</td>
<td>2166</td>
<td>1155742</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Affymetrix tiling arrays</th>
<th>Number of columns / rows</th>
<th>Perfect match probes (Genomatix optimized)</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Promoter 1.0 R</td>
<td>2166</td>
<td>3967233</td>
<td></td>
</tr>
<tr>
<td>Mouse Promoter 1.0 R</td>
<td>2166</td>
<td>3943515</td>
<td></td>
</tr>
<tr>
<td>Arabidopsis Tiling 1.0R</td>
<td>2560</td>
<td>2888551</td>
<td></td>
</tr>
<tr>
<td>Arabidopsis Tiling 1.0F</td>
<td>2560</td>
<td>2888550</td>
<td></td>
</tr>
<tr>
<td>Drosophila Tiling 2.0R</td>
<td>2560</td>
<td>2726143</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Affymetrix expression arrays</th>
<th>Number of columns / rows</th>
<th>Perfect match probes (Genomatix optimized)</th>
<th>Transcripts (Genomatix annotated)</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabidopsis ATH1 Genome</td>
<td>712</td>
<td>220039</td>
<td>29840</td>
<td>A. thaliana</td>
</tr>
<tr>
<td>Bovine Genome</td>
<td>732</td>
<td>199713</td>
<td>16861</td>
<td>B. taurus</td>
</tr>
<tr>
<td>C. elegans Genome</td>
<td>712</td>
<td>213496</td>
<td>20501</td>
<td>C. elegans</td>
</tr>
<tr>
<td>Canine Genome Ver 2</td>
<td>732</td>
<td>383133</td>
<td>39164</td>
<td>C. familiaris</td>
</tr>
<tr>
<td>Chicken Genome</td>
<td>984</td>
<td>315499</td>
<td>15996</td>
<td>Gallus</td>
</tr>
<tr>
<td>Human Genome U133Plus2.0</td>
<td>1164</td>
<td>525438</td>
<td>61158</td>
<td>H. sapiens</td>
</tr>
<tr>
<td>Human Genome U133A</td>
<td>712</td>
<td>207689</td>
<td>39876</td>
<td></td>
</tr>
<tr>
<td>Human Genome U133A 2.0</td>
<td>732</td>
<td>207689</td>
<td>39876</td>
<td></td>
</tr>
<tr>
<td>Human Genome U133B</td>
<td>712</td>
<td>222339</td>
<td>22693</td>
<td></td>
</tr>
<tr>
<td>Human Genome U95Av2</td>
<td>640</td>
<td>169901</td>
<td>24755</td>
<td></td>
</tr>
<tr>
<td>Human Genome FL (6800)</td>
<td>536</td>
<td>103884</td>
<td>15267</td>
<td></td>
</tr>
<tr>
<td>Human Genome U219 Plate</td>
<td>744</td>
<td>472423</td>
<td>143190</td>
<td></td>
</tr>
<tr>
<td>500K_Sty</td>
<td>2560</td>
<td>1610660</td>
<td>12329</td>
<td></td>
</tr>
<tr>
<td>500K_Nsp</td>
<td>2560</td>
<td>1612024</td>
<td>10303</td>
<td></td>
</tr>
<tr>
<td>Maize Genome</td>
<td>730</td>
<td>188040</td>
<td>64195</td>
<td>Z. mays</td>
</tr>
<tr>
<td>Mouse Expression Set 430 A</td>
<td>712</td>
<td>207750</td>
<td>62161</td>
<td></td>
</tr>
<tr>
<td>Mouse Expression Set 430 B</td>
<td>712</td>
<td>220386</td>
<td>34676</td>
<td></td>
</tr>
<tr>
<td>Mouse Genome 430 2.0</td>
<td>1002</td>
<td>427307</td>
<td>89995</td>
<td></td>
</tr>
<tr>
<td>Mouse Genome 430A 2.0</td>
<td>732</td>
<td>207750</td>
<td>62161</td>
<td></td>
</tr>
<tr>
<td>Murine Genome U74v2 A</td>
<td>640</td>
<td>141087</td>
<td>37949</td>
<td></td>
</tr>
<tr>
<td>Chimpanzee on HG-U133Plus2.0</td>
<td>1164</td>
<td>398160</td>
<td>76364</td>
<td>P. troglodytes</td>
</tr>
<tr>
<td>Poplar Genome</td>
<td>1162</td>
<td>355285</td>
<td>27395</td>
<td>P. trichocarpa</td>
</tr>
</tbody>
</table>

© 2011 Genomatix Software GmbH
### Affymetrix expression arrays cont’d

<table>
<thead>
<tr>
<th>Array Provider</th>
<th>Number of columns / rows</th>
<th>Perfect match probes (Genomatix optimized)</th>
<th>Transcripts (Genomatix annotated)</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rat Expression Set 230 A</td>
<td>602</td>
<td>144141</td>
<td>18676</td>
<td>R. norvegicus</td>
</tr>
<tr>
<td>Rat Genome 230 2.0</td>
<td>834</td>
<td>284875</td>
<td>26353</td>
<td></td>
</tr>
<tr>
<td>Rat Genome U34 A</td>
<td>534</td>
<td>100954</td>
<td>8056</td>
<td></td>
</tr>
<tr>
<td>Rhesus Macaque Genome</td>
<td>1164</td>
<td>590073</td>
<td>40644</td>
<td>M. mulatta</td>
</tr>
<tr>
<td>Rice Genome</td>
<td>1164</td>
<td>513875</td>
<td>55024</td>
<td>O. saliva</td>
</tr>
<tr>
<td>Soybean Genome</td>
<td>1164</td>
<td>276821</td>
<td>31938</td>
<td>G. max</td>
</tr>
<tr>
<td>Vitis vinifera Genome</td>
<td>730</td>
<td>146487</td>
<td>8892</td>
<td>V. vinifera</td>
</tr>
<tr>
<td>Xenopus tropicalis Genome</td>
<td>1162</td>
<td>426244</td>
<td>33458</td>
<td>X. tropicalis</td>
</tr>
<tr>
<td>Zebrafish Genome</td>
<td>712</td>
<td>152434</td>
<td>8716</td>
<td>D. rerio</td>
</tr>
</tbody>
</table>

### Other Array providers

<table>
<thead>
<tr>
<th>Provider</th>
<th>Number of identifiers</th>
<th>Perfect match probes (Genomatix optimized)</th>
<th>Transcripts (Genomatix annotated)</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agilent</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Genome, 12391 (G4112A)</td>
<td>41675</td>
<td>29678</td>
<td>106485</td>
<td>H. sapiens</td>
</tr>
<tr>
<td>Human Genome, 14850 (G4112F)</td>
<td>43376</td>
<td>1379</td>
<td>82289</td>
<td></td>
</tr>
<tr>
<td>SurePrint G3 Human 8x60k</td>
<td>62972</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Promoter, 014706/014707 (G4489A)</td>
<td>474411</td>
<td>473123</td>
<td>47281</td>
<td></td>
</tr>
<tr>
<td>Illumina</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human RefSeq 8, Version 2.0</td>
<td>22185</td>
<td>21448</td>
<td>78853</td>
<td>H. sapiens</td>
</tr>
<tr>
<td>Human RefSeq 8, Version 3.0</td>
<td>24526</td>
<td>23750</td>
<td>81826</td>
<td></td>
</tr>
<tr>
<td>Human Whole Genome 6, Version 2.0</td>
<td>48702</td>
<td>45347</td>
<td>88337</td>
<td></td>
</tr>
<tr>
<td>Human Whole Genome 6, Version 3.0</td>
<td>48804</td>
<td>45480</td>
<td>92754</td>
<td></td>
</tr>
<tr>
<td>Human HT 12.0 Version 3</td>
<td>48803</td>
<td>45775</td>
<td>135472</td>
<td></td>
</tr>
<tr>
<td>Mouse RefSeq 8, Version 2.0</td>
<td>25697</td>
<td>24972</td>
<td>90332</td>
<td>M. musculus</td>
</tr>
<tr>
<td>Mouse Whole Genome 6, Version 2.0</td>
<td>45281</td>
<td>43331</td>
<td>116468</td>
<td></td>
</tr>
<tr>
<td>Rat RefSeq 12</td>
<td>22523</td>
<td>20968</td>
<td>39569</td>
<td>R. norvegicus</td>
</tr>
</tbody>
</table>
4. File Requirements

ChipInspector has a number of requirements for the data files. The files as they are produced in the experiment usually meet all of them, but if the files cannot be analyzed, it might be advisable to check the following list:

1. The chip type given in the data file must be compliant with the (currently) 69 chips supported (cf. the list of accepted chip types).

2. The files should be stored locally or on a mounted drive. Please be aware that, depending on the file format and your network protocol, remote storage could cause increased time demand.

3. File extension: ChipInspector analyzes files with the .cel or .CEL extensions in case of Affymetrix microarrays. For other chip providers, tab-delimited files are expected and a data import interface is displayed.

We recommend a minimum of three replicates per experimental point. It is possible to work with two replicates, but the statistical evaluation should be considered with caution. It is not possible to have less than two replicates per experimental point, because this makes statistics non-utilizable.

5. Technical Requirements

5.1 Operating Systems

The application has been tested on the following operating systems:

Windows: Windows XP, Windows Vista

Macintosh: At least MacOS X 10.4

Linux/Unix systems: SuSE Linux 8.0 or above, or equivalent version of other distributors

Minimum system requirements:

- 5 GB hard disc space
- 1 GB RAM (recommended 2GB)
- 1 GHz processor speed

If you do not have any of these operating systems, or if you are not sure about your operating system, please contact the Genomatix customer support (support@genomatix.de).
5.2 Java Runtime Environment

In order to run the ChipInspector application, you will need **Java 1.6** or higher.

To test if you have an appropriate Java version already installed on your system, type

```
java -version
```

on command line.

Here is an example for windows users how to check the installed java version:

Click on Start/All Programs/Accessories/Command Prompt (see screenshot below).
A command window will pop up:

```
C:\WINDOWS\System32> java -version
```

Type in `java -version` and press Enter.

If Java is installed, you will get an output like:

```
java version "1.6.0_04"
Java(TM) SE Runtime Environment (build 1.6.0_04-b12)
Java HotSpot(TM) 64-Bit Server VM (build 10.0-b19, mixed mode)
```

If Java is **not** yet installed on your computer, or if you have a Java version older than 1.6.0, please follow the link http://www.java.com/ to download and install the newest version of Java (at least version 1.6.0).
6. Installation and Configuration of ChipInspector

ChipInspector is a JAVA program which must be installed locally on your computer. Please proceed for download and installation as follows.

6.1 Download

To download ChipInspector, please follow the following steps:

1. Create a folder on you hard disk where you want to store the installer
3. Choose your operating system from the download
4. Click on the download button next to your operating system

<table>
<thead>
<tr>
<th>download</th>
<th>File size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP, Vista</td>
<td>55 MB</td>
</tr>
<tr>
<td>MacOS X (10.5)</td>
<td>55 MB</td>
</tr>
<tr>
<td>Linux/Unix</td>
<td>55 MB</td>
</tr>
<tr>
<td>User Manual</td>
<td>5 MB</td>
</tr>
</tbody>
</table>

Clicking on the download-icon will result in the following screen:

Choose the option “save to disk” and click “ok”
A window will show up, where you can choose a folder to save the file. Choose the folder where you would like to save the installer and press ok.

Mac users will find a folder named “GenomatixApplications” on their desktop or in their designated download folder. It contains an installer package, a ReadMe and the license file. Double clicking the “GenomatixApplications” installer package will start the installation of the software.
6.2 Get Login and Password

To apply the ChipInspector application you require a Genomatix user account with login and password. Registration for a two-week trial account is free of charge. An e-mail with your personal username and password will be sent to you immediately.

6.2.1. Registration

Open your internet browser and navigate to www.genomatix.de.

Click on "Login" in the left frame of the webpage.
If you do not have an account yet, please click on “Register”.

Fill in the form – please enter your e-mail correctly.
Check your e-mail. A mail with your login data should be sent to you right away.

---

Dear Bernd Buttermann,

your registration for a Genomatix evaluation account was successful! Here are your account details:

Login name: buttermann
password: s3jbijpvz

Please note that username AND password are case-sensitive.

You will find the Genomatix Suite at
http://portail.0.genomatix.de/cgi-bin/v2/sideroad/main.pl
You can change your password using the "change password" link at the top of the program page or on your "personal profile" page.

You can also subscribe to unlimited ChipInspector access on your "personal profile" page.

If you should run into trouble logging onto our server, please first read
http://portail.0.genomatix.de/online.htm/spg/tenbtpw.html

After that do not hesitate to contact us in case of any problems or questions.

Best regards,

Your Genomatix support team

The login and password is not only valid for ChipInspector but for all Genomatix products.
6.2.2 Change Password

Open your internet Browser and switch to www.genomatix.de.

Click on “Login” on the webpage (see above)

Enter your login and password which was sent to you via e-mail.
After login you will see the following page. Click on “Password”.

Fill in the form and click on “Change Password” to change your password.
6.2.3 Password Policy

Genomatix’ password policy requires all passwords to be at least 6 characters long and must contain at least one non-alphabetic or capital character. No blanks or tabs are allowed.

6.3 Installation

Switch to the folder on your hard disk where the installer was saved. Execute the installer (see below) and follow the instructions.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP, Vista</td>
<td>Double click on the Genomatix install icon in the folder</td>
</tr>
<tr>
<td>MacOS X (10.5)</td>
<td>Copy the ChipInspector application to your Applications folder</td>
</tr>
<tr>
<td>Linux/Unix</td>
<td>Type &quot;Java -jar InstellGenomatixApplications.jar&quot;</td>
</tr>
</tbody>
</table>

Please note that the Genomatix licensing model for ChipInspector is a single-user floating license. This means that you may install the program on any number of machines, however not run several instances of the program at the same time. If a second instance of ChipInspector is started while another instance is running, the user is given the choice of ending the concurring session. This can lead to data loss on the first instance if the analysis results have not been stored yet. The above said is true also for parallel instances of ChipInspector 2 and older versions. The programs may be run alternately, but not at the same time.
If you run a Windows system, the following screen will pop up:

Click “Next >” and follow the instructions.

After ChipInspector is installed successfully, you can start the application either from the program group “Genomatix” with the executable “ChipInspector” by double-clicking the “ChipInspector” icon on your desktop.
6.4 Configuration of ChipInspector

Before you start working with ChipInspector, please take a minute to configure the application concerning the proxy configuration for internet access and the application update behavior to get the latest program version automatically.

6.4.1 Proxy Configuration

Many companies and institutions use proxies and firewalls for secure and fast access to the Web. ChipInspector will try to learn the appropriate settings from your preferred browser application (InternetExplorer or Firefox), but it may be necessary to configure these settings to allow the application to pass your local proxy or firewall.

In ChipInspector, go to the “Tools” menu and select “Options”.

In the “General” tab, tell the application whether to use the proxy known to your computer or to use a manual setting which you will be able to receive from your institution’s system administrator.
6.4.2 Configuring automatic updates

Periodically Genomatix provides important ChipInspector updates. The Genomatix Update Service helps you to keep your application current.

In ChipInspector, go to the "Tools" menu and select "Plugins".

In the "Settings" tab, set the interval of automatic update checks.

If you select “Never”, then the application will only update itself if you manually start this process.
When an updated version of the program is available, you will be notified by a symbol in the bottom right corner of the screen.

Click this icon to update ChipInspector automatically or go to the "Help" menu and select "Check For Updates".

### 6.4.4. Selecting a Data Server

If data downloads are slow, a different data server may be closer to your geographical location. Configure the data server which you want to use by going to the "Tools" menu and selecting "Options".

In the "Download" tab, choose the server for data download.
6.4.5. Configuring the Java memory settings

Every Java program such as ChipInspector runs within a defined environment, the Java Virtual Machine (JVM). When a Java program is started, the computer allocates a portion of its main memory (its RAM) to the JVM. When ChipInspector is first installed, the amount of allocatable RAM is calculated. However, this calculation may be off or new hardware RAM may have been added subsequently. It is possible to increase the portion of RAM for the JVM, thus giving ChipInspector more memory:

**Step 1:** Find out how much RAM your computer has. Under Windows, this parameter can e.g. be found in the System Properties Control Panel. Here, you can also find out whether you have a x64 operating system.

**Step 2:** Find out which Java machine is installed. See page 15 for details.

**Step 3:** Calculate the portion of RAM for the Java Machine.

If you have a x64 operating system and a suitable x64 Java installed, then the maximum memory manageable by the JVM lies between 3000 and 3400 Megabyte. If this is not the case, the limit is between 1500 and 1700 Megabyte. Leave at least 200 Megabyte for internal computer processes.

**Step 4:** Edit the file which starts ChipInspector accordingly:

Under Windows, right-click the ChipInspector icon and choose "Properties". In the "Shortcut" tab, edit the last number in the "Target" box accordingly. For example, if you decide that 1300 Megabyte of RAM can be allocated to the JVM, the end of the line should read:

```bash
...\chipinspector.exe -J-Xmx1300m
```

**Step 5:** When the RAM portion size is not compatible with your computer setup, the JVM (and thus ChipInspector) will not start. Redo step 3 until ChipInspector is functional again.
7 Step-by-step: Performing a ChipInspector Analysis

When the program starts, a login screen asks for your Genomatix account credentials. If you have no account with Genomatix yet, please refer to page 20 of this manual for instructions on how to activate an account. Enter username and password and click “Ok”.

On the welcome page, a wizard is provided to guide you through the creation of a project, the data import and the analysis. All steps are also accessible via the program interface. If you previously deactivated the “Welcome” page, you can re-enable it in the Help menu.

Click the “ChipInspector” logo in the “Available modules” column.

In Step 1, an input form is displayed, which asks for a project name.

Enter a name for the new project and click “Finish”.

© 2011 Genomatix Software GmbH
In the next step, the raw data files are imported. The wizard opens this dialog automatically.

Depending on the type of data choose “CEL-File Import” for Affymetrix or “Tabular File Import” for other platforms.

Click “Next”.

Use the upper “Browse…” button to navigate to the folder where the data files are located.

Choose the appropriate data files in the FileChooser dialog and click “Open”.

© 2011 Genomatix Software GmbH
The program will attempt to recognize the chip type.

You may have to select the chip type manually if it is not recognizable from the data file. In this case, please select the chip type from the list of supported chips.

Click “Next”.

The data files are imported into the project.

Click “Finish”.

The wizard now presents the “New Analysis” workflow.

In the first step, you are asked to choose the appropriate statistical assay form (see p. 9 for explanations of the various statistical assays possible):

Click “Next”.

© 2011 Genomatin Software GmbH
Provide a name for the analysis.

Click “Next”.

The data files for the project are presented in the central file list.

Select the control files and associate them with the “Control” list.

Christian Zinser 15.7.08 16:36
Kommentar: Screenshot passt nicht – das sind Treatment Files

Christian Zinser 15.7.08 15:48
Kommentar:
Select the files that represent the experimental condition and associate them with the "Treatment" list.

Click "Next".

Choose the file combinations for the statistical analysis (see p.9 for an explanation of the possible variants).

Click "Next".

The time required for an analysis depends on the size of the microarray, the size of the data set and the hardware.

The program gives an overview of the progress.

When the analysis is finished, click "Finish".
ChipInspector displays a table with the analysis results.

The “Probes” table shows the significant single probes detected on the chip ordered by chromosomal position.

The program allows various views on the data. In section 9, each view is explained in detail.

Click the “Window” menu item to see a list of display options.

8 Variant: Chromatin-IP workflow

ChipInspector can be used for the evaluation of Chromatin-IP experiments. In this case, the workflow is amended. Chromatin-IP experiments are targeted towards sharply defined regions of the genome, where the immunoreaction produces a signal.

It is therefore not advisable to use the transcript list view to see annotated genomic regions defined by single probes. Instead, use the Probe Filters (section 8.9) to define the size of the significant regions in basepairs and the minimum number of probes that this region should contain.

Export the resulting significant regions as a .bed-file (File – Export). Use this bed-file as input in Genomatix’ RegionMiner, a program found on our webserver.

RegionMiner provides information on Transcription Factor binding sites independent of annotation and strand specificity and is thus optimally suited for Chromatin-IP evaluation.
9 The ChipInspector Workspace Area

The Menu item “Window” shows a list of different data view options, which can be turned on and off and are explained in detail in this section. Each view presents various aspects of the data:

<table>
<thead>
<tr>
<th>Data View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects</td>
<td>projects and analyses which are currently open.</td>
</tr>
<tr>
<td>Genome Browser</td>
<td>probes graphically in the genomic environment</td>
</tr>
<tr>
<td>Gene Information</td>
<td>known annotation of a selected gene</td>
</tr>
<tr>
<td>Transcript View</td>
<td>alternative transcripts for the selected locus</td>
</tr>
<tr>
<td>Significance Curve</td>
<td>result curve of the statistical calculation for the experiment</td>
</tr>
<tr>
<td>Properties</td>
<td>properties of the selected project or analysis</td>
</tr>
<tr>
<td>Probe Filters</td>
<td>parameters used for selecting subsets of the data</td>
</tr>
<tr>
<td>Transcript Filters</td>
<td></td>
</tr>
</tbody>
</table>

Size and screen position of all windows are manageable.
9.1 The “Projects” Window

The project management panel shows the currently open projects and analyses in a tree structure. Right-clicking on an item in the tree opens a context menu for performing actions on the respective object such as data import or starting a new analysis.

Only the menu items with a meaningful function for the current state of the object will be activated.

9.2 The “Probes” Window

ChipInspector displays a table with the analysis results. The “Probes” table shows the significant single probes detected on the chip ordered by chromosomal position. For each single probe, the following information is displayed from left to right:

- chromosome number
- start position of the probe on the chromosome
- length of the probe
- strand where the probe is mapped to
- statistical significance score of the probe in the experiment
- significant region into which this probe is grouped
- the transcripts to which this probe is assigned
- the fold change (log₂) that this probe shows in the experiment

When a table cell is selected, the corresponding information is updated correspondingly in the other windows.

The list is filtered according to the filter settings in the “Probe Filters” window. Clicking the “transcripts” tag in the table header toggles the view to display the transcripts that are associated with the probes in the list.
The result list lists the significantly regulated transcripts and their probe coverage (i.e. the number of significant probes that map to the transcript exons from left to right):

- the NCBI GeneID
- the official gene symbol
- the RefSeq Accession Number
- the coverage of this transcript by significant probes
- the average fold change of all significant probes for this transcript

Clicking the accession number will update the “Alternative Transcripts” window and display all alternative transcripts at this locus. If there is significant evidence for both up and down regulation of a transcript, two entries are listed for it, displaying the according positive and negative fold changes.

The list can be sorted by any column by clicking on its header.

When a table cell is selected, the corresponding information is updated correspondingly in the other windows.
The list is filtered according to the filter settings in the “Transcript Filters” window. Clicking the “transcripts” tag in the table header toggles the view to display the transcripts that are associated with the probes in the list.

<table>
<thead>
<tr>
<th>Gene ID</th>
<th>Gene Symbol</th>
<th>Accession Number</th>
<th>Coverage</th>
<th>Log Fold Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>6516</td>
<td>SNAP25</td>
<td>AK029732</td>
<td>3</td>
<td>5.16</td>
</tr>
<tr>
<td>9976</td>
<td>SLC22A8</td>
<td>AK031052</td>
<td>5</td>
<td>-5.17</td>
</tr>
<tr>
<td>6519</td>
<td>SLC3A1</td>
<td>AK051392</td>
<td>3</td>
<td>-5.44</td>
</tr>
<tr>
<td>11075</td>
<td>STIM1</td>
<td>AK052137</td>
<td>4</td>
<td>5.67</td>
</tr>
<tr>
<td>4758</td>
<td>ATP1A3</td>
<td>AK054523</td>
<td>3</td>
<td>5.33</td>
</tr>
<tr>
<td>4757</td>
<td>ATP1A3</td>
<td>AK122533</td>
<td>4</td>
<td>5.45</td>
</tr>
<tr>
<td>2546</td>
<td>GAP43</td>
<td>AK123311</td>
<td>3</td>
<td>5.94</td>
</tr>
<tr>
<td>6229</td>
<td>CUBN</td>
<td>AK141391</td>
<td>3</td>
<td>-5.12</td>
</tr>
<tr>
<td>6519</td>
<td>SLC3A1</td>
<td>AK223143</td>
<td>4</td>
<td>-5.21</td>
</tr>
<tr>
<td>4758</td>
<td>ATP1A3</td>
<td>AK223580</td>
<td>4</td>
<td>5.99</td>
</tr>
<tr>
<td>5692</td>
<td>SNAP91</td>
<td>AK269582</td>
<td>3</td>
<td>5.7</td>
</tr>
<tr>
<td>6519</td>
<td>SLC3A1</td>
<td>AK280635</td>
<td>3</td>
<td>-5.44</td>
</tr>
<tr>
<td>4155</td>
<td>MBP</td>
<td>AK289993</td>
<td>4</td>
<td>5.18</td>
</tr>
<tr>
<td>229</td>
<td>ADOR6</td>
<td>AK290745</td>
<td>4</td>
<td>-5.2</td>
</tr>
<tr>
<td>4311</td>
<td>MME</td>
<td>AK291751</td>
<td>5</td>
<td>-5.23</td>
</tr>
<tr>
<td>476</td>
<td>ATP1A3</td>
<td>AK307521</td>
<td>3</td>
<td>5.48</td>
</tr>
<tr>
<td>5798</td>
<td>KCN1J</td>
<td>AK308033</td>
<td>4</td>
<td>-5.75</td>
</tr>
<tr>
<td>6519</td>
<td>SLC3A1</td>
<td>AK309115</td>
<td>3</td>
<td>-6.44</td>
</tr>
<tr>
<td>5554</td>
<td>PLP1</td>
<td>AK079279</td>
<td>5</td>
<td>5.15</td>
</tr>
<tr>
<td>5798</td>
<td>KIP5A</td>
<td>AK112145</td>
<td>3</td>
<td>5.54</td>
</tr>
<tr>
<td>1014</td>
<td>CD115</td>
<td>AK113101</td>
<td>3</td>
<td>-5.24</td>
</tr>
<tr>
<td>5514</td>
<td>HIC1A</td>
<td>AK1141147</td>
<td>1</td>
<td>-4.43</td>
</tr>
</tbody>
</table>

Clicking the button “ElDorado” at the bottom of this window opens a browser with a view of the selected transcript in Genomatix’ annotation browser ElDorado.

This is especially helpful when the analysis is based on an older version of ElDorado, therefore disabling the graphic view in ChipInspector. The ElDorado view can then still be used to see the genomic environment of the selected transcript.
9.4 The “Genome Browser” Window

The Genome Browser shows the genome annotation at the specified locus. It automatically repositions the view if a probe or a transcript is selected in another view. The following elements are extracted from Genomatix’ ElDorado database and displayed in the graph:

<table>
<thead>
<tr>
<th>Element Color</th>
<th>Element Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Primary transcript</td>
</tr>
<tr>
<td></td>
<td>Exon</td>
</tr>
<tr>
<td></td>
<td>Promoter</td>
</tr>
<tr>
<td></td>
<td>3' UTR</td>
</tr>
<tr>
<td></td>
<td>Transcription start region, based on CAGE tag evidence</td>
</tr>
<tr>
<td></td>
<td>Up-regulated probe significant / non-significant</td>
</tr>
<tr>
<td></td>
<td>Down-regulated probe significant / non-significant</td>
</tr>
</tbody>
</table>

The elements on the forward strand are displayed above the black line; the elements on the reverse strand are located beneath the black line. The vertical size of the probe reflects the fold change in the experiment. Tool tip texts give additional information about the elements.

The following graph explains the various functions:
A region that is selected by clicking and drawing the mouse can be displayed in the genome annotation browser ElDorado by clicking the corresponding button.

A comprehensive overview over all the transcription factor binding sites that are located in the selected region can be obtained by clicking the MatInspector button.

A browser window is opened in both cases taking you directly to the corresponding Genomatix webpage.

Please note that this feature depends on synchronized genome versions in ChipInspector and ElDorado and is therefore disabled, when an analysis is based on an older version of the genome.

9.5 The “Gene Information” Window

A digest of the comprehensive annotation from ElDorado is presented. The link behind the GeneID leads to a complete overview of the information in the various databases on the Genomatix servers while the button “ElDorado” leads directly to the “More Gene Info” page of ElDorado.
9.6 The “Alternative Transcripts” Window

The Transcript View shows the various alternative transcripts at the specified locus. It automatically repositions the view if a transcript is selected in another view. The following elements are extracted from Genomatix’ ElDorado database and displayed in the graph:

<table>
<thead>
<tr>
<th>Element Color</th>
<th>Element Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary transcript</td>
<td></td>
</tr>
<tr>
<td>Exon</td>
<td></td>
</tr>
<tr>
<td>Promoter</td>
<td></td>
</tr>
<tr>
<td>3' UTR</td>
<td></td>
</tr>
<tr>
<td>Transcription start region, based on CAGE tag evidence</td>
<td></td>
</tr>
<tr>
<td>Up-regulated probe significant / non-significant</td>
<td></td>
</tr>
<tr>
<td>Down-regulated probe significant / non-significant</td>
<td></td>
</tr>
</tbody>
</table>

The elements on the forward strand are displayed above the black line; the elements on the reverse strand are located beneath the black line. The vertical size of the probe reflects the fold change in the experiment. Tool tip texts give additional information about the elements.

The NCBI GeneID and the RefSeq accession number are shown for each alternative transcript; the Genomatix LocusID and the gene symbol are shown at the bottom of the window.

The following graph explains the various functions:
9.7 The “Significance Curve” Window

For an explanation of the statistical algorithm which is applied in ChipInspector, please refer to page 9 in this manual.

The resulting significance curve is displayed for each analysis. The observed ratio values are plotted against the expected ratio values.

The color intensity of the curve mirrors the number of features with the corresponding Observed/Expected coordinates, scaled in the bar on the right. Most of the features will be grouped around the center of the graph near Zero.

By right-clicking the graph, you have access to zooming functions.

9.8 The “Properties” Window

A right-click on any object in the program opens a “Properties” window. Here, the parameters, description texts and file locations for the selected object are displayed.

In the case of an analysis, this includes e.g. the chip type, the file combination and the EiDorado database version, on which this analysis is based.
9.9 The “Probe Filters” Window

Each single probe in the analysis has a statistical score and a defined position in the genome.

The list of probes can thus be restricted either by the significance score or by their proximity to other significant probes.

Please refer to p. 9 in this manual for an explanation of the Delta value and False Discovery Rate. The sliders in the Probe Filters window are used to vary this parameter in the analysis. The “Significant Feature” number is an estimation at this point and the numerical value may deviate in the resulting probe list, especially at low Delta settings.

In general, a more stringent statistic score (a higher Delta) results in less significant features with a higher confidence (lower FDR).

To define regions of significant probes, a sliding window approach is utilized, the parameters here are the window size (in basepairs) and the number of required significant probes within this region.
9.10 The “Transcript Filters” Window

Each transcript which is included in the microarray is detected by one or more single probes. This filter is used to select the number of significant single probes that detect a transcript before this transcript is deemed significant. The default of 3 should be set to 1 for non-Affymetrix arrays.

This filter is also used to restrict the number of transcripts in the result list by a minimum fold change. The parameter refers to the average fold change of all significant probes which detect this transcript.

9.11 The “Unique Probe Statistics” Window

By selecting one or more imported data files in the “Projects” Window and right-clicking, you can select the action “Show Unique Probe Statistics” and view a low-level assessment of the raw data.

The displayed values give an estimate whether the raw data files in the analysis are on comparable expression levels.

By right-clicking the graph, you have access to zooming functions.
9.12 The “Memory Monitor”

Click “View – Toolbars – Memory” to display a memory monitor in the toolbar field.

Click the memory monitor to free unused memory.
10 Projects and Analyses

10.1 Creating a New Project

To create a new project, select “File – New Project…” from the menu, or click on the “New Project” toolbar button.

A form is displayed which asks for a project type. Currently, only one type of project is supported, the “New Project”.

Click “Next”.

An input form is displayed, asking for a project name.

Enter a name for the new project and click “Finish”.

© 2011 Genomatin Software GmbH
10.2 Opening an Existing Project

To open a previously saved project, select “File - Open Project…” from the menu, or click on the Open Project toolbar button, and select a project tree file from the dialog.

10.3 Saving the Project Tree

To save the project tree, including all projects, analyses and results, select “Save” from the File menu, or click on the Save All toolbar button.

10.4 Deleting a Project

To delete a project, including all analyses and results, right-click the project in the projects window and select “Delete” from the context menu.

10.5 Importing Data Files into a Project

To import data files into your project, click the “New Action” button in the task bar or right-click the appropriate project and select “New” from the context menu.

Select “Cel-File Import” from the context menu.
In the next step, the raw data files are imported. The wizard opens this dialog automatically.

Depending on the type of data, choose “CEL-File Import” for Affymetrix or “Tabular File Import” for other platforms.

Click “Next”.

Use the upper “Browse...” button to navigate to the folder where the data files are located.

Choose the appropriate data files in the File Chooser dialog and click “Open”.
The program will attempt to recognize the chip type. You may have to select the chip type manually if it is not recognizable from the data file. In this case, please select the chip type from the list of supported chips. Click “Next”.

If non-CEL files are imported, a preview step is interposed allowing you to select the data rows and columns which are relevant for the subsequent analysis.

Choose the separator, which marks the columns, identify the first row where data is located and finally select those columns, which hold the relevant data.

Only one column may be designated as holding the feature ID. ChipInspector expects the identifier for the unique and singular tag sequence.
The unique identifier for Agilent probe sequences is the “featureNum” entity, which is displayed in column 2 of the Agilent scanner output. If the output comes from a GenePix scanner, the corresponding unique identifier is the “RefNumber” in column 57.

The unique identifier for Illumina probe sequences is the ArrayAddressID, which is displayed in the Bead Studio output. This is not the Illumina ProbeID (starting with “ILMN_”), but rather the strictly numeric ArrayAddressID.

The number of columns that can hold expression data from the experiment is not restricted.

The data files are imported into the program.

Click “Finish”.

© 2011 Genomatix Software GmbH
10.6 Editing a Project

Right-click on the project node in the “Projects Window” to perform a number of tasks on the project:

- **New**
  - Importing additional data files for analysis
  - Starting a new analysis on imported data files
- **Renaming**
- **Deleting**
- **Copying** to another directory (i.e. for sharing the result with collaborators)
- **Closing**
- **Moving** to another location on your computer
- **Set As Main Project**: this project will be suggested as the default project when a new analysis is started
- **Editing the project Properties** (i.e. adding a description text)
10.7 Creating a New Analysis

To create a new analysis, right-click on a project node and select “New” – “Other Action”.

Choose an analysis type from the selection; please refer to page 9 for a more in-depth explanation. Available types are:

**Treatment/Control Pairing**

Use this option if you want to perform a one-class analysis, which compares a treated sample to a control. A single sided permutation T-test analysis is performed.

**Time Course/Titration Experiment**

Select this option if you want to compare a set of data points in a multi-class analysis, e.g. for subsequent cluster analysis of the results in other programs. In this case a multi-class permutation T-test analysis is performed.

**Presence/Absence Calling**

Choose this option if you want to measure expression values relative to the average expression on the chip, e.g. for gene expression values in one specific tissue. In this case a permutation T-test analysis detecting probes which are significantly above the experiment average is performed. Biological replicates with n>=2 are still required.

Click “Next”.
Provide a name for the analysis.

Click “Next”.

The data files for the project are presented in the central file list.

If “Treatment/Control” is selected, two windows are displayed to which the respective files are assigned.

Select the control files and associate them with the “Control” list.
Select the files that represent the experimental condition and associate them with the “Treatment” list.

Click “Next”.

If “time Course/Titration” is selected, you are additionally asked to choose the number of experimental conditions, which are relevant for this analysis.

Assign the files accordingly; control files may be associated with more than one experimental class, while each treatment file may be associated with only group.

Click “Next”.

Accordingly, when “Presence/Absence” is chosen, there is only field displayed which accepts all the files for the current analysis.

Click “Next”.
Choose the file combinations for the statistical analysis (see p.9 for an explanation of the possible variants).

The program will display the combination of the files accordingly, when the combination type is selected.

Click “Next”.

If you select “Finish” at this point, the analysis is stored for later inclusion into a batch job, i.e. when more than one analysis is run in one continuous process.

The time required for an analysis depends on the size of the microarray, the size of the data set and the hardware.

The program gives an overview of the progress.

When the analysis is finished,

Click “Finish”.

Please refer to page 38 for a description of the various data views which are presented by the program.
10.8 Committing an Analysis for a Batch Job

Right-click the project or select “New Action” from the menu bar to display the possible actions and select “Analysis Batch Job” from the list.

Click “Next”.

Select those analyses which you want to run in one continuous process, e.g. overnight.

Click “Next”. 
10.9 Exporting Results

You can export the results in different formats for further analysis. To do so, click on “File - Export” in the menu and choose from the available export options:

10.9.1 Data Export

Both the transcript list and the probe list can be exported as a table for MS Excel or other spreadsheet programs. This table will contain the following data:

- Chromosome
- Position
- Length
- Strand
- Significance Score
- Region
- Transcript
- Fold Change (log2)

10.9.2 Bed-file Export

The probe list can be exported as a .bed-file for further downstream analysis in Genomatix RegionMiner or other annotation programs. It will show the significant regions:

- Chromosome
- Start position
- End position
10.9.3 Transcript List Export

If the table of transcripts is exported and the fold changes for every data combination are required, additional columns for these data will be included in the output file.

Alternatively, the transcript list can be exported in a format which is compliant with Genomatix’ *BiblioSphere* and *PathwaySystem*. 